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Annexure 2 

    (Refers to Para 2 of Appendix A) 

PRIMER 

MDP ORSA: FEB 2026 

MS EXCEL (BASICS) 

 

General 

1. Excel is an electronic spreadsheet program that is used for storing, organizing 

and manipulating data. Data is stored in individual cells that are usually organized 

in a series of columns and rows in a worksheet; this collection of columns and 

rows is referred to as a table. 

 

2. Spreadsheets programs can also perform calculations on the data 

using formulas. To help make it easier to find and read the information in a worksheet, 

Excel has a number of formatting features that can be applied to individual cells, rows, 

columns, and entire tables of data. 

 

3. Since each worksheet in recent versions of Excel contains billions of cells per 

worksheet, each cell has an address known as a cell reference so that it can be 

referenced in formulas, charts, and other features of the program. 

 

4. Active Cell. The active cell is recognized by its green outline. Data is always 

entered into the active cell. Different cells can be made active by clicking on them with 

the mouse or by using the arrow keys on the keyboard. 

 

5. Add Sheet Icon. Clicking on the Add sheet icon next to the Sheet tab at 

the bottom of the screen adds another worksheet. (You can also use two keyboard 

shortcuts to add a new worksheet: Shift+F11 and Alt+Shift+F1). 

 
  

https://www.lifewire.com/spreadsheet-program-definition-and-uses-3124000
https://www.lifewire.com/how-to-multiply-in-excel-3124086
https://www.lifewire.com/description-of-formula-3123848
https://www.lifewire.com/excel-format-painter-copy-formatting-4117553
https://www.lifewire.com/parts-of-the-excel-screen-p2-3123485
https://www.lifewire.com/cell-references-relative-absolute-and-mixed-3123401
https://www.lifewire.com/active-cell-definition-3123375
https://www.lifewire.com/data-definition-excel-3123415
https://www.lifewire.com/add-worksheets-using-excel-shortcuts-4178183
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Excel Screen Elements  

 

 
 

6. Column Letters. Columns run vertically on a worksheet, and each one is 

identified by a letter in the column header like A, B, ….. Z, AA, AB and so on. 

 

7. Row Numbers. Rows run horizontally in a worksheet and are identified by 

a number starting from 1 in the row header. 

 

8. Cell.   Cells are the rectangular boxes located in the central area of a 

worksheet.  

8.1  Data entered into a worksheet is stored in a cell. Each cell can hold only 

one piece of data at a time. 

 

8.2  A cell is the intersection point of a vertical column and a horizontal 

row. 

 

8.3   Each cell in the worksheet can be identified by a cell reference, 
which is a combination of letters (column reference) and numbers (row 
reference) such as A1, F456, or AA34. Here A1 cell refers to Column A and 
Row 1. 

 
9. Formula Bar. Located above the worksheet, this area displays the 
contents of the active cell. The formula bar can also be used for entering or editing 
data and formulas. 
 

https://www.lifewire.com/worksheet-and-workbook-3124111
https://www.lifewire.com/column-and-row-headings-3123610
https://www.lifewire.com/column-and-row-headings-3123610
https://www.lifewire.com/what-is-a-spreadsheet-cell-4178208
https://www.lifewire.com/cell-references-relative-absolute-and-mixed-3123401
https://www.lifewire.com/formula-bar-fx-bar-3123846
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10. Name Box.   Located next to the formula bar, the Name Box displays the cell 

reference or the name of the active cell. 

 

11. Quick Access Toolbar.    It allows you to add frequently used, commands, 

click on the down arrow at the end of the toolbar to display available options. 

 

12. Ribbon. The Ribbon is the strip of buttons and icons located above the 

worksheet. When clicked on, these buttons and icons activate the various features of 

the program.  

 

13. Ribbon Tabs. They are part of the horizontal ribbon menu that contains 

links to various features of the program. Each tab – such as Home, Page Layout, and 

Formulas contains a number of related features and options that are activated by 

clicking on the appropriate icon. 

 

14. File Tab.    Clicking on the File tab opens a drop-down menu on the left side of 

the screen. 

 

14.1 This tab contains items that are mostly related to file and document 

management, such as opening new or existing worksheet files, saving, and 

printing. 

 

14.2 The Options item, which is also located on the menu, is used to alter the 

look of the program as a whole by choosing which screen elements to display, 

such as scroll bars and gridlines; it also contains options for activating a number 

of settings including automatic recalculation of worksheet files and choosing 

which languages to use for spell check and grammar 

 
15. Sheet Tabs.      By default, there is one worksheet in an Excel 2013 file, but 
you can add additional sheets. The Sheet tab at the bottom of a worksheet tells you 
the name of the worksheet, such as Sheet1 or Sheet2. 
 

15.1  Renaming a worksheet or changing the tab color can make it easier to 

keep track of data in large spreadsheet files. 

 

15.1  Switching between worksheets can be done by clicking on the tab of the 

sheet you want to access. (You can also switch between worksheets with 

the keyboard shortcut to change between worksheets: Ctrl+PgUp and 

Ctrl+PgDn) 

 

16 Status Bar.    It runs horizontally along the bottom of the screen, can be 

customized to display a number of options, most of which give the user information 

about the current worksheet, data the worksheet contains, and the user's keyboard. 

 

https://www.lifewire.com/the-name-box-and-its-many-uses-3123863
https://www.lifewire.com/define-a-named-range-in-excel-3123627
https://www.lifewire.com/description-of-ribbon-3123973
https://www.lifewire.com/how-to-rename-a-worksheet-3123471
https://www.lifewire.com/change-worksheet-tab-colors-in-excel-4020732
https://www.lifewire.com/moving-between-worksheets-in-excel-3124024
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16.1 Information includes whether the Caps Lock, Scroll Lock, and Num 

Lock keys are turned on or off. 

 

16.2  The status bar also contains the Zoom slider, which allows users to 

alter the magnification of a worksheet. 

 

17 Zoom Slider. Located in the bottom right corner of the Excel screen, the 

Zoom slider is used to change the magnification of a worksheet when you drag the 

slider box back and forth or click on the Zoom Out and Zoom In buttons located at 

either end of the slider. 

Entering Data into Your Worksheet  

 

18 Entering data into worksheet cells is always a three-step process; these steps 

are as follows: 

 

18.1  Click on the cell with mouse or navigate through the keyboard arrow 

keys where you want the data to go (click on cell B2). 

 

18.2  Type the data into the cell (Type Shyam). 

 

18.3  Press the Enter key on the keyboard or click on another cell with the 

mouse. 

 

18.4  To enter multiple data, after typing data in cell B2, use either mouse to 

go to a particular cell or use navigation arrow keys to move to adjacent cells. 

For e.g. after typing Shyam in cell B2, use right arrow navigation key to move 

to cell C2 and type Gupta. 

https://www.lifewire.com/zoom-in-changing-worksheet-magnification-3124114
https://www.lifewire.com/spreadsheet-program-definition-and-uses-3124000
https://www.lifewire.com/what-is-a-spreadsheet-cell-4178208
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Auto-Completing a Series 
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Excel Math Functions 

 
Quickly Sum Columns or Rows of Numbers in Excel 

19 The SUM Function Syntax and Arguments. 

 

19.1   A function's syntax refers to the layout of the function and 

includes the function's name, brackets, and arguments. The syntax for the 

SUM function is: 

 

19.2    =SUM(Number1,Number2,...Number255) 

 

19.3   Number1 (required) is the first value to be summed. This 

argument can contain the data you want to sum up, or it can be a cell reference 

to the location of the data in the worksheet. 

 

19.4   Number2, Number3, ... Number255 (optional) is the additional 

values to be summed up to a maximum of 255. 

 
20 Sum Data in Excel Using AutoSUM.  

 

 
 

20.1   Use the AutoSUM shortcut located on the Home tab of the ribbon 

to complete the formula without having to type. 

 

20.2   The "Auto" part of the name AutoSUM refers to the method 

automatically selecting what it believes is the range of cells to be summed by 

the function. The selected range is shaded and surrounded by an animated 

border known as marching ants. 

 

https://www.lifewire.com/description-of-syntax-3124001
https://www.lifewire.com/argument-definition-3123376
https://www.lifewire.com/data-definition-excel-3123415
https://www.lifewire.com/cell-references-relative-absolute-and-mixed-3123401
https://www.lifewire.com/worksheet-and-workbook-3124111
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20.3   The AutoSUM function should be input at the bottom of 

a column of data or the right end of a row of data. If you put the AutoSUM 

function in another spot on the spreadsheet, the range of cells selected as the 

function's argument may be incorrect. To change the selected range, use the 

mouse pointer to highlight the correct range before pressing the Enter key to 

complete the function 

 

21 To use AutoSUM 

 

21.1   Click the cell where you want the result to display and click the 

AutoSUM icon on the ribbon.  

 

21.2   Check to see that the selected range, which will form the 

function's argument, is correct. If it's accurate, press the Enter key on the 

keyboard to complete the function. The answer will display in the cell. When 

you click on the cell containing the solution, the completed SUM function 

appears in the formula bar above the worksheet. 

 

22 Using the SUM Function Dialog Box  

 

 

23 Most functions in Excel can be entered using a dialog box, which allows you to 

input the arguments for the function on separate lines. The dialog box also takes care 

of the function's syntax, such as the opening and closing parentheses and the commas 

used to separate individual arguments. Although individual numbers can be entered 

directly into the dialog box as arguments, it is usually best to enter the data into 

worksheet cells and enter the cell references as arguments for the function. 

 

https://www.lifewire.com/column-definitions-excel-3123398
https://www.lifewire.com/dialog-box-dialog-box-launcher-3123860
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24 To enter the SUM function using the dialog box: 

 

24.1  Click the cell where the results will be displayed. 

24.2  Click on the Formulas tab of the ribbon menu. 

24.3  Choose Math & Trig from the ribbon to open the function drop-down 

list. 

24.4  Click SUM in the list to bring up the function's dialog box. 

24.5  Click the Number1 line in the dialog box. 

24.6  Highlight at least one cell reference or a range of references. 

24.7  Click OK to complete the function and close the dialog box. 
 

Using Excel's PRODUCT Function 

25 Numbers, Arrays, or Ranges of Values.   The product is the result of a 

multiplication operation. The numbers shown in cells A1 to A3 of the example below 

can be multiplied together using one of two methods 

 

25.1  A formula containing the multiply (*) mathematical operator (see row 5 

for an example). 

 

25.2  The PRODUCT function as shown in row 6. 
 

 

 

26 The PRODUCT function comes into play when multiplying the data in many 

cells. For example, in row 9 in the image, the formula: 

    =PRODUCT(A1:A3,B1:B3) is equivalent to the formula: =A1*A2*A3*B1*B2*B3 

https://www.lifewire.com/description-of-ribbon-3123973
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27 Syntax and Arguments.    The syntax for the PRODUCT function is: 

 =PRODUCT(Number1,Number2,...,Number255 ) 

27.1   Number1 (required) is the first number or array that you want to 
multiply. This argument can be the actual numbers, cell references, or 
the range of the location of data in the worksheet. 

 
27.2   Number2, Number3,...,Number255 (optional) are additional 
numbers, arrays, or ranges up to a maximum of 255 arguments. 

 
28 An Example of the PRODUCT Function.    The PRODUCT function is entered 
into an Excel worksheet by either typing the complete function into the Formula Bar or 
by using the Function Arguments dialog box. To find the product when multiplying cells 
A1, A2, and A3, you could type the formula. Select an empty cell, such as A4, and 
type the function: 
 

 =PRODUCT(A1:A3) ; Press Enter. 

29 Although it is possible to enter the complete function manually, it is easier to 

use the dialog box because it takes care of adding the function's syntax, such as 

brackets and comma separators between arguments. 

 

30 To enter the PRODUCT function using the Function Arguments dialog 

box: 

 

30.1  Select cell A4 to make it the active cell. 

30.2  On the ribbon, go to Formulas. 

30.3  Select Math & Trig. 

30.4  Select PRODUCT. 

30.5  In the Function Arguments dialog box, place the cursor in 

the Number1 text box. 

 

31 If the active cell is directly beneath a group of cells, Excel may automatically 

add the cell references. If you don't want to use these cell references, delete the 

references. 

 

31.1  On the worksheet, highlight cells A1 to A3 to add this range to the dialog 

box. 

 

31.2  In the Function Arguments dialog box, select OK to complete the 

function and to close the dialog box. 

 

31.3  The answer 750 appears in cell A4 because 5*10*15 equals 750. 

https://www.lifewire.com/cell-references-relative-absolute-and-mixed-3123401
https://www.lifewire.com/description-of-range-3123975
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31.4  Select cell A4 to view the complete function in the Formula Bar above 

the worksheet. 

 

 
 

 

Video for Multiplication -  

https://www.youtube.com/watch?v=BjvoT2wQ9MA 

Video for excel basic arithmetic operations (add, subtract, multiply and divide) 

https://www.youtube.com/watch?v=1naiWCWfSt4 

https://www.youtube.com/watch?v=BjvoT2wQ9MA
https://www.youtube.com/watch?v=1naiWCWfSt4
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Switch between Relative, Absolute, and Mixed References 

32 By default, a cell reference is a relative reference, i.e. the reference is relative 

to the location of the cell. As an example, if you copy the formula =B4*C4 from cell 

D4 to D5, the formula in D5 adjusts to the right by one column and becomes =B5*C5. 

To maintain the original cell reference when you copy it, make the cell reference 

absolute by preceding the columns (B and C) and row (2) with a dollar sign ($). Then, 

when you copy the formula =$B$4*$C$4 from D4 to D5, the formula stays exactly the 

same. 

 

33 Absolute and relative cell references can be mixed by preceding either the 

column or the row value with a dollar sign—which fixes either the column or the row 

(for example, $B4 or C$4). 

 

34 To change the type of cell reference 
 

34.1  Select the cell that contains the formula. 
 
34.2  In the formula bar , select the reference that you want to change. 

 
34.3   Press F4 to switch between the reference types. 

 

35 The table below summarizes how a reference type updates if a formula 

containing the reference is copied two cells down and two cells to the right. 

 

For a formula being 
copied: 

If the reference is: It changes to: 

$A$1 (absolute column & 
absolute row) 

$A$1 (the reference is 
absolute) 

 

A$1 (relative column & 
absolute row) 

C$1 (the reference is 
mixed) 

$A1 (absolute column & 
relative row) 

$A3 (the reference is 
mixed) 

A1 (relative column & 
relative row) 

C3 (the reference is 
relative) 



30 
 

 

SUMPRODUCT Function 

36 The SUMPRODUCT function returns the sum of the products of corresponding 

ranges or arrays. The default operation is multiplication, but addition, subtraction, and 

division are also possible. 

 

37 Syntax. To use the default operation (multiplication): 

 

=SUMPRODUCT(array1, [array2], [array3], ...)  

 

38 The SUMPRODUCT function syntax has the following arguments: 

 

Argument Description 

array1   Required The first array argument whose components you 

want to multiply and then add. 

[array2], array3], Optional Array arguments 2 to 255 whose components you 

want to multiply and then add. 

 

39 To perform other arithmetic operations. Use SUMPRODUCT as usual, 

but replace the commas separating the array arguments with the arithmetic operators 

you want (*, /, +, -). After all the operations are performed, the results are summed as 

usual. 

 

40 The array arguments must have the same dimensions. else, SUMPRODUCT 

returns the #VALUE! error value. For example, =SUMPRODUCT(C2:C10,D2:D5) will 

return an error as the ranges aren't the same size. 

 

SUMPRODUCT treats non-numeric array entries as if they were zeros. 

Tutorial on SUMPRODUCT function : 

https://www.youtube.com/watch?v=Lc52EQrztcc  

 

Example  
 

To create the formula using sample list given, 

type in formula bar 

=SUMPRODUCT(C2:C5,D2:D5) and press 

Enter. Each cell in column C is multiplied by 

its corresponding cell in the same row in 

column D, and the results are added up. The 

total amount for the groceries is $78.97. 

 

https://www.youtube.com/watch?v=Lc52EQrztcc
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MMULT function (Matrix Multiplication) 

41 The MMULT function returns the matrix product of two arrays. The result is an 

array with the same number of rows as array1 and the same number of columns as 

array2. The formula must be entered as an array formula by first selecting the output 

range, entering the formula in the top-left-cell of the output range, and then pressing 

CTRL+SHIFT+ENTER to confirm it. Excel inserts curly brackets at the beginning and 

end of the formula for you. 

 

42 Syntax 

MMULT(array1, array2) 

Argument - array1, array2  Required (The arrays you want to multiply). 
 

43 Remarks. 
 

43.1  The number of columns in array1 must be the same as the number of 

rows in array2, and both arrays must contain only numbers. 

 

43.2  Array1 and array2 can be given as cell ranges, array constants, or 

references. 

43.3  MMULT returns the #VALUE! error when 

43.3.1 Any cells are empty or contain text. 

43.3.2  The number of columns in array1 is different from the 

number of rows in array2. 

44   The matrix product array a of two arrays b and c is:  

44.1  
where i is the row number, and j is the column number. 

 
Example 



32 
 

 
Video for MMULT Function   

 

https://www.youtube.com/watch?v=Vu8ONniwY-A 

 

Additional material on the usage of MS Excel may be accessed at 

https://support.office.com/en-us/article/excel-for-windows-training-9bc05390-e94c-

46af-a5b3-d7c22f6990bb.  

 

Basic tutorial on excel may be viewed at 

https://www.youtube.com/watch?v=rwbho0CgEAE 

https://www.youtube.com/watch?v=Vu8ONniwY-A
https://support.office.com/en-us/article/excel-for-windows-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb
https://support.office.com/en-us/article/excel-for-windows-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb
https://www.youtube.com/watch?v=rwbho0CgEAE

